Cisco ICM Software Custom Screen Builder User Guide

ICM Software Version 5.0
CONTENTS

Preface  i
   About This Guide   i
   Other Documentation   iii
   Obtaining Technical Assistance   iv

CHAPTER 1
Getting Started with Custom Screen Builder  1
   About Custom Screen Builder   1
   CSB Support for ICM WebView and CEM WebView   1
   How to Install Custom Screen Builder   2
   How to Access Custom Screen Builder   2
   About the Custom Screen Builder Interface   3

CHAPTER 2
Introduction to Report Templates   7
   About ICM Report Template Attributes   7
   About ICM Databases   8
   About WebView Report Categories   8
   About SQL Select Statements   9
   About Template Presentation Formats   10
   About Planning a New Report Template   10

CHAPTER 3
Creating a New Report Template   13
   Step 1: Select the Template Database   13
   Step 2: Specify the Report Category   15
   Step 3: Select the Presentation Style and Data Source   16
   Step 4: Create the SQL Statement   17
   Step 5: Design the Template Layout   23
   Step 6: Preview the Template   28
   Step 7: Save the Template   29

CHAPTER 4
Editing and Deleting Templates   31
   How to Edit a Template   31
   How to Delete a Template   32
Preface

This preface describes this guide’s scope and intended audience. It also provides general information on accessing Cisco product documentation and getting assistance with Cisco products. It contains these sections:

- About This Guide
- Other Documentation
- Obtaining Technical Assistance

About This Guide

Objective

This guide provides instructions for using the Cisco Intelligent Contact Management (ICM) software Custom Screen Builder to create and modify report templates used in the ICM WebView. WebView is the Web-based reporting tool of ICM software.

Audience

This guide is intended for Cisco Admin Workstation users who create and/or modify report templates for use in WebView reports. This guide assumes that you have knowledge of:

- ICM WebView and WebView reports
- ICM database table structures
- Relational databases and Structured Query Language (SQL).

Familiarity with Sybase InfoMaker is also useful.
For instructions on installing and setting up WebView, see the *Cisco ICM Software WebView Installation Guide*. For instructions on using WebView, see the *Cisco ICM Software WebView User Guide*. For information on ICM databases, see the *Cisco ICM Software Database Schema Handbook* and the Schema Help available from the Cisco Admin Workstation program group.

### Conventions

This guide uses the following conventions:

<table>
<thead>
<tr>
<th>Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boldface type is used for menu, tab, field, and command names.</td>
<td>From the <strong>File</strong> menu, select <strong>Save As</strong>.</td>
</tr>
<tr>
<td>Courier type is used for file names, directory paths, code, and user input.</td>
<td>Peripheral services templates are stored in the <code>persvc</code> subdirectory.</td>
</tr>
<tr>
<td>Italic type indicates one of the following:</td>
<td>• A <em>skill group</em> is a collection of agents who share similar skills.</td>
</tr>
<tr>
<td>• A newly introduced term</td>
<td>• Templates with computed columns created in the Report Painter <em>will not</em> support WebView’s drill-down and threshold capabilities.</td>
</tr>
<tr>
<td>• An emphasized word or phrase</td>
<td>• For more information, see the <em>Cisco ICM Software Database Schema Handbook</em>.</td>
</tr>
<tr>
<td>• The title of a publication</td>
<td>An entry enclosed within angle brackets (<code>&lt;&gt;</code>) indicates a variable.</td>
</tr>
<tr>
<td></td>
<td>Save the file to the <code>icm&lt;icm_instance_name&gt;</code> directory.</td>
</tr>
<tr>
<td>A right angle bracket indicates an item from a pull-down menu or a series of sequential commands in a tabular dialog box or Wizard.</td>
<td>Select <strong>Peripheral &gt; Create a Report</strong> to browse to the custom templates.</td>
</tr>
</tbody>
</table>
Other Documentation

Obtaining Documentation

Additional Cisco product documentation is available from the following sources:

World Wide Web

You can access all current ICM documentation, as well as documentation on other Cisco products, at:

http://www.cisco.com

Translated documentation is available at:


Documentation CD-ROM

Cisco documentation and additional literature are available in a Cisco Documentation CD-ROM package, which is shipped with your product. The Documentation CD-ROM is updated monthly and may be more current than printed documentation. The CD-ROM package is available as a single unit or through an annual subscription.

Ordering Documentation

You can order Cisco documentation in these ways:

- Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from the Networking Products MarketPlace:
  
  http://www.cisco.com/cgi-bin/order/order_root.pl

- Registered Cisco.com users can order the Documentation CD-ROM through the online Subscription Store:
  
  http://www.cisco.com/go/subscription

- Nonregistered Cisco.com users can order documentation through a local account representative by calling Cisco Systems Corporate Headquarters (California, U.S.A.) at 408 526-7208 or, elsewhere in North America, by calling 800 553-NETS (6387).

Documentation Feedback

You can submit comments electronically on Cisco.com. In the Cisco Documentation home page, click the Fax or Mail option in the “Leave Feedback” section at the bottom of the page.
You can e-mail your comments to bug-doc@cisco.com.
You can submit your comments by mail by using the response card behind the front cover of your document or by writing to the following address:
Cisco Systems
Attn.: Document Resource Connection
170 West Tasman Drive
San Jose, CA 95134-9883
We appreciate your comments.

Obtaining Technical Assistance

Cisco provides Cisco.com as a starting point for all technical assistance. Customers and partners can obtain online documentation, troubleshooting tips, and sample configurations from online tools by using the Cisco Technical Assistance Center (TAC) Web Site. Cisco.com registered users have complete access to the technical support resources on the Cisco TAC Web Site.

Cisco.com

Cisco.com is the foundation of a suite of interactive, networked services that provides immediate, open access to Cisco information, networking solutions, services, programs, and resources at any time, from anywhere in the world.
Cisco.com is a highly integrated Internet application and a powerful, easy-to-use tool that provides a broad range of features and services to help you with these tasks:
- Streamline business processes and improve productivity
- Resolve technical issues with online support
- Download and test software packages
- Order Cisco learning materials and merchandise
- Register for online skill assessment, training, and certification programs

If you want to obtain customized information and service, you can self-register on Cisco.com. Access Cisco.com at:
http://www.cisco.com

Technical Assistance Center

The Cisco Technical Assistance Center (TAC) is available to all customers who need technical assistance with a Cisco product, technology, or solution. Two levels of support are available: the Cisco TAC Web Site and the Cisco TAC Escalation Center.
Cisco TAC inquiries are categorized according to the urgency of the issue:

- **Priority level 4 (P4)**—You need information or assistance concerning Cisco product capabilities, product installation, or basic product configuration.
- **Priority level 3 (P3)**—Your network performance is degraded. Network functionality is noticeably impaired, but most business operations continue.
- **Priority level 2 (P2)**—Your production network is severely degraded, affecting significant aspects of business operations. No workaround is available.
- **Priority level 1 (P1)**—Your production network is down, and a critical impact to business operations will occur if service is not restored quickly. No workaround is available.

The Cisco TAC resource that you choose is based on the priority of the problem and the conditions of service contracts, when applicable.

**Cisco TAC Web Site**

You can use the Cisco TAC Web Site to resolve P3 and P4 issues yourself, saving both cost and time. The site provides around-the-clock access to online tools, knowledge bases, and software. Access the Cisco TAC Web Site at:

http://www.cisco.com/tac

All customers, partners, and releasers who have a valid Cisco service contract have complete access to the technical support resources on the Cisco TAC Web Site. The Cisco TAC Web Site requires a Cisco.com login ID and password. If you have a valid service contract but do not have a login ID or password, you can register at:

http://www.cisco.com/register/

If you are a Cisco.com registered user, and you cannot resolve your technical issues by using the Cisco TAC Web Site, you can open a case online by using the TAC Case Open tool at:

http://www.cisco.com/tac/caseopen

If you have Internet access, we recommend that you open P3 and P4 cases through the Cisco TAC Web Site.

**Cisco TAC Escalation Center**

The Cisco TAC Escalation Center addresses priority level 1 or priority level 2 issues. These classifications are assigned when severe network degradation significantly impacts business operations. When you contact the TAC Escalation Center with a P1 or P2 problem, a Cisco TAC engineer automatically opens a case.

A directory of toll-free Cisco TAC telephone numbers for your country is available at:

Before calling, please check with your network operations center to determine the level of Cisco support services to which your company is entitled: for example, Smartened, Smartened Insight, or Network Supported Accounts (NSA). When you call the center, please have available your service agreement number and your product serial number.
Getting Started with Custom Screen Builder

This chapter describes Custom Screen Builder capabilities, gives instructions for installing and accessing the product, and provides a brief description of the InfoMaker interface. It contains these sections:

- About Custom Screen Builder
- CSB Support for ICM WebView and CEM WebView
- How to Install Custom Screen Builder
- How to Access Custom Screen Builder
- About the Custom Screen Builder Interface

About Custom Screen Builder

ICM’s Custom Screen Builder allows you to create and modify the templates which serve as the basis for reports available through ICM WebView. WebView is ICM’s Web-based monitoring tool, presenting call center information in both real-time and historical reports. WebView ships with many predefined templates that cover a wide range of standard industry report formats. Eventually, however, you may want to create your own report templates, or modify those delivered with WebView. You do this through Custom Screen Builder. Custom Screen Builder is built on, and derives its interface from, Sybase’s® InfoMaker™ software.

Note

For more information on ICM WebView, see the Cisco ICM Software WebView User Guide.

CSB Support for ICM WebView and CEM WebView

ICM 5.0 ships with two “flavors” of WebView.

- ICM WebView reports on activity logged in ICM databases. It is installed on the ICM Admin Workstation server.
• **CEM WebView** reports specifically in Cisco eMail Manager activity. It is installed on the Cisco E-Mail Manager server.

*Cisco supports Custom Screen Builder creation and modification of templates for ICM WebView only. Creation and modification of CEM Webview templates via Custom Screen Builder is not supported. All discussion of template creation, modification, and distribution in this guide should be understood to pertain to ICM WebView only. For more information on CEM WebView templates, consult your Cisco representative.*

## How to Install Custom Screen Builder

You install Custom Screen Builder as an option when you install the ICM Admin Workstation. Prior to installing the Admin Workstation, you MUST first install Sybase InfoMaker, version 8.0 on the server. Without a previous installation of InfoMaker, Custom Screen Builder will not be available for use.

To install Custom Screen Builder:

1. Install Sybase InfoMaker, version 8.0, on the same server on which you will be installing the ICM Admin Workstation.

2. Install the Admin Workstation. During the installation:


   b. Click the **Browse** button next to the check box, and browse to select the directory where InfoMaker is installed.

### Caution

Custom Screen Builder for use with ICM 5.0 supports InfoMaker, version 8.0 only. Other InfoMaker versions are not supported.

### Caution

If you install InfoMaker AFTER installing the Admin Workstation software, you must rerun Admin Workstation Setup before Custom Screen Builder will be available for use. For more information on installing the Admin Workstation, see the *Cisco ICM Software Installation Guide*.

## How to Access Custom Screen Builder

You access Custom Screen Builder through the ICM Admin Workstation. For this reason, you need to Admin Workstation privileges in order to use Custom Screen Builder. No other privileges are necessary to use the product.
To start Custom Screen Builder:

1. From the ICM Admin Workstation program group, select **Custom Screen Builder**. This launches InfoMaker running under ICM.

---

**About the Custom Screen Builder Interface**

Custom Screen Builder is built upon, and uses as its interface, InfoMaker 8.0. Launching Custom Screen Builder automatically opens InfoMaker.

*Note*: This guide does not include a full description of all InfoMaker features; it limits itself to the context of using InfoMaker to create and edit ICM report templates. For information on using InfoMaker features not described in this guide, see your InfoMaker documentation.

Most of the tasks related to report template in InfoMaker take place in the following three *Painter* windows:

- The *Library Painter* allows you to browse and view libraries and their contents.
- The *SQL Select Painter* allows you to define a template’s SQL select statement.
- The *Report Painter* allows you to design the layout for a template.

For descriptions and instructions on how and when to use these windows, see Chapter 3, “Creating a New Report Template.”

---

**Figure 1-1  InfoMaker Main Window**
The commands available to you in InfoMaker may vary depending on the configuration specified in your InfoMaker installation. Commands that appear in the default InfoMaker installation are described in the table below.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New" /></td>
<td>Use to create a new object (i.e., a report template).</td>
</tr>
<tr>
<td><img src="image" alt="Open" /></td>
<td>Use to open an existing object (i.e., a report template or query) from the current library.</td>
</tr>
<tr>
<td><img src="image" alt="Preview" /></td>
<td>Use to preview a report template from the current library.</td>
</tr>
<tr>
<td><img src="image" alt="Sel Lib" /></td>
<td>Use to select the current library file. (You can also do this from within the Library Painter. For instructions, see Chapter 3, “Step 2: Specify the Report Category.”)</td>
</tr>
<tr>
<td><img src="image" alt="Lib List" /></td>
<td>Use to add additional libraries to your search list (e.g., to locate library files that have been transferred from another Admin Workstation).</td>
</tr>
<tr>
<td><img src="image" alt="ToDo" /></td>
<td>Use to open the To-Do List, a user-defined list of outstanding tasks for the current library.</td>
</tr>
<tr>
<td><img src="image" alt="Library" /></td>
<td>Use to open the Library painter, which allows you to browse and access libraries and their contents.</td>
</tr>
<tr>
<td><img src="image" alt="DB Prof" /></td>
<td>Use to set the current database connection, and to create or modify database profiles (connection information).</td>
</tr>
</tbody>
</table>
Table 1-1  InfoMaker Main Window Commands (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Database Icon" /></td>
<td>Use to open the Database painter, which allows you to maintain databases and database tables, control user access to databases, and manipulate data in databases</td>
</tr>
<tr>
<td><img src="image" alt="Exit Icon" /></td>
<td>Use to exit InfoMaker.</td>
</tr>
</tbody>
</table>
Introduction to Report Templates

This chapter describes the basic attributes that define and shape ICM report templates. It also describes points you should consider when planning a template. It contains these sections:

- About ICM Report Template Attributes
- About ICM Databases
- About WebView Report Categories
- About SQL Select Statements
- About Template Presentation Formats
- About Planning a New Report Template

About ICM Report Template Attributes

Each ICM WebView report template is defined and shaped by the following four basic attributes:

- Database: When you create a template, you specify whether it should include either real-time data (from the Admin Workstation local database) or historical data (from the ICM central database, or optionally, the ICM distributor database).
- Report Category: When you create a template, you save it to a PowerBuilder library file that associates it with a specific WebView report category (e.g., call type, peripheral services, etc.).
- SQL Statement: When you create a template, you construct a Structured Query Language (SQL) select statement that determines what data is included in the report.
- Presentation Format: When you create a template, you specify its presentation format. The presentation format determines the format in which the report is rendered. ICM Webview templates can use either a graph (graphical) or grid (text) presentation format.
For example, you can create a historical template for peripheral services that retrieves the total number of tasks handled by certain peripheral services and which displays the data in a grid report.

**About ICM Databases**

Report templates can be created to include either real-time data or historical data.

- **Real-time data** describe conditions as they currently exist. Real-time data are stored in the *Admin Workstation Local Database* (RealTimeDB). Each Admin Workstation contains a real-time database. The real-time database stores configuration data for call center entities (e.g., services and skill groups) and real-time data for those entities. Real-time data are updated at regular intervals (the default is 15 seconds) for up-to-the-minute accuracy.

- **Historical data** describe conditions during a specified period of time, for example, a range of dates. Historical data are stored in two places:
  - The *ICM central database* (HistoricalDB) located on the central controller. The ICM central database stores configuration data for call center entities and historical data for those entities.
  - Optionally, the *ICM distributor database* (Historical Database Server or HDS), an Admin Workstation set up to store historical data so that other Admin Workstations at the site can read historical data from the HDS rather than accessing the central database. The ICM distributor database stores historical data only; it does not store configuration data.

**Note**

For descriptions of the tables contained in ICM databases, see the *Cisco ICM Software Database Schema Handbook*.

**About WebView Report Categories**

ICM report templates are stored in and accessed from PowerBuilder library files (PBLs) on your ICM Admin Workstation server. A separate library file exists for each WebView report category (e.g., call type, routing clients, etc.), and the library file for each report category is stored in its own subdirectory within the `icm\<icm_instance_name>\aw\custom` directory.

It’s important that you select the appropriate library when creating a new template: this is what associates the template with a specific report category, ensuring that it displays under the correct menu in WebView and has access to the correct retrieval values.

For more information, including a complete list of WebView report categories, see Appendix B, “Template Libraries and Report Categories.”
About SQL Select Statements

WebView templates use SQL select statements to determine what data to retrieve from the database. Select statements for WebView templates always include a Where clause that uses retrieval arguments to narrow the focus of a report to specific ICM entities and, in the case of historical reports, a specific date/time range. When they launch a report, WebView users are prompted to provide values for these arguments.

The following shows a sample SQL select statement from a WebView report:

```sql
SELECT Service.EnterpriseName, Service_Real_Time.CallsOfferedHalf
FROM Service, Service_Real_Time
WHERE (Service.SkillTargetID=Service_Real_Time.SkillTargetID) and
((Service.SkillTargetID in (:list_of_persvc)))
```

In this example, the Where clause requests data based on skill target ID. A skill target is an ICM entity (such as a service, skill group, or agent) to which an ICM task is routed. A skill target ID is the unique identifier for a skill target. (:list_of_persvc) is the retrieval argument that accepts the list of skill target IDs specified by WebView users when they launch the report.

About Required Retrieval Arguments

WebView prompts users to provide a fixed set of argument values when launching a report:

- Real-time reports always use one argument—a list of IDs that represent the entities listed in the report.
- Historical reports always use three arguments—a list of IDs, and start and end date/times that define the report’s time frame.

When creating a new template, you must create retrieval arguments in your SQL select statement to accept these values. Note that these are the only arguments WebView supports.

About Complex Report Templates

This guide provides the basic information needed to create most report templates. However, some templates (for example, the enterprise services and enterprise skill groups) mandate the use of complex SQL statements and advanced InfoMaker features. For example, many enterprise templates use:

- Long lists of computed fields defined within the SQL syntax
- Rows joined across three or more database tables
- Group By clauses, which must be defined within the SQL syntax, and cannot be viewed through the InfoMaker graphical interface
If you need assistance to create more complex report templates, ask your Cisco representative about consulting services.

**Caution**

By default, InfoMaker defines inner joins. If you purchased the partitioning option, using outer joins may cause errors for some ICM tables.

---

### About Template Presentation Formats

A template’s presentation format determines the format in which the report is rendered. ICM Webview templates can use either a graph (graphical, including pie charts, bar charts, etc.) or grid (text) presentation format. Both real-time and historical reports can be presented in either graph or grid format.

### About Planning a New Report Template

Before creating your first report template, you should be familiar with the ICM database schema. It’s also a good idea to examine some of the standard templates that ship with ICM to familiarize yourself with their content and structure.

*Any time* you create a new template, you should first consider the following:

- **Which ICM database will the template use?**
  Will the template’s data be real-time or historical? A template can use data from only one source: real-time data, from the Admin Workstation local database, or historical data, from the ICM central database or HDS.

- **What ICM entity will the template report on?**
  The ICM entity you want to target (e.g., agents, call types, peripheral services) determines the template’s Webview report type, and consequently the particular template library in which it should be stored. For more information on libraries and WebView report types, see Appendix B, “Template Libraries and Report Categories.”

- **What data will appear in the template?**
  Which database tables and columns do you want to include in the template? For information on ICM databases, see the *Cisco ICM Software Database Schema Handbook* and the Schema Help available from the Cisco Admin Workstation program group.
What arguments will the template require to retrieve data?

WebView users are prompted to specify certain data retrieval parameters when launching a report template:

- Real-time reports always provide one argument—a list of IDs that represent the entities listed in your report.
- Historical reports always provide three arguments—a list of IDs, and start and end dates and times that specify the period of time represented in your report.

What computed fields, if any, will the template include?

Your template can include computed columns that reflect calculations based on the values of two more database columns. Computed columns can be created at two points in the template creation process: when creating the template’s SQL statement (in the SQL Select Painter), or when designing the template’s layout (in the Report Painter).

What presentation format will the template use, graph or grid?

ICM templates can use either a grid (text) or graph (graphical) presentation format.

Will a modified version of an existing template suit your needs?

You can edit an existing template and save it under a different name, thus creating a new template from an existing one. Instructions for modifying existing templates are described in Chapter 4, “Editing and Deleting Templates.”
Creating a New Report Template

This chapter describes the steps required to create a new report template. Except where specified, these steps are common to both real-time and historical reports. Creating a template involves these steps:

1. Select the Template Database
2. Specify the Report Category
3. Select the Presentation Style and Data Source
4. Create the SQL Statement
5. Design the Template Layout
6. Preview the Template
7. Save the Template

Note: If this is your first new template, be sure to first review the information in Chapter 2, “Introduction to Report Templates.” In particular, review the information in the "About Planning a New Report Template" section.

Step 1: Select the Template Database

The first step in creating a new report template is to specify which ICM database the template will use.

About ICM Databases

The ICM database you choose for your template will depend on whether you are creating a real-time or historical report:

- Real-time report templates must use the Admin Workstation local database.
- Historical report templates must use the ICM central database or, optionally, the ICM distributor database.
How to Specify the Database for a Template

To specify the database for a template:

1. On the InfoMaker toolbar, click DB Prof. The Database Profiles dialog box opens.
2. From the ODBC interface, select either RealTimeDB (the Admin Workstation local database) or HistoricalDB (the ICM central database).

Note

If either of these profiles is absent from the dialog box, you can add them as described in the next section, How to Create an ICM Database Profile.

3. Click Connect.
4. Click Close.

Figure 3-1 The Database Profiles Dialog Boxes
How to Create an ICM Database Profile

If a profile does not already exist for either the Admin Workstation local or ICM central database, you can create one as follows:

1. In the Database Profiles dialog box, highlight the ODBC entry.
2. Click New. The Database Profiles setup - ODBC dialog box opens.
3. On the Connection tab, enter:
   - Profile Name: Enter the profile name (RealTimeDB or HistoricalDB).
   - Data Source: Select the appropriate ICM data source.
   - Login ID: Enter the database’s administrator ID.
   - Password: Enter the database’s administrator password.
4. On the Options tab, check the Integrated Security checkbox (required to successfully connect the database).
5. Click OK.

Step 2: Specify the Report Category

After selecting the database, the next step in creating a report template is to specify the template’s report category.

About WebView Report Categories Libraries

ICM report templates are stored in and accessed from PowerBuilder library files (PBLs) on your ICM Workstation server. A separate library file exists for each Webview report category (e.g., call type, routing clients, etc.). By saving a template to a specific library, you associate it with a specific report category.

The library file for each report category is stored in its own subdirectory within the icm\<icm_instance_name>\aw\custom directory. For example, the library for the category call type is stored in a subdirectory named caltyp. The same library file stores both real-time and historical reports.

For more information on WebView report categories and library files, see Appendix B, “Template Libraries and Report Categories.”

How to Specify the Report Category

To specify the report category for a new template, you must set that category’s library file as the current InfoMaker library. Later, when you save the template, it will automatically save to that library.
To select the current library:
1. From the InfoMaker main window, on the toolbar, click Library. The Library Painter window opens.

2. Browse to the subdirectory for the WebView report category in which you want to create the template (a list of all report categories appears in Appendix B, “Template Libraries and Report Categories.”

3. Right-click on the subdirectory’s library file (p pb050. pbl). From the popup menu, select Set as Working Library.

**Step 3: Select the Presentation Style and Data Source**

After selecting the database and template library, the next step in creating a report template is specify its presentation style and data source.

**About Presentation Styles and Data Sources**

Presentation style determines the format in which reports based on a template are displayed in WebView. WebView supports two InfoMaker presentation styles:
- Grid (text-based in grid format), and...
- Graph (graphical--including pie charts, bar charts, line charts, etc.)
Other presentation styles available in InfoMaker (e.g., Free Form, Composite) are not supported.

The data source determines how data is extracted from the database. WebView supports only SQL Select. Other data source methods available in InfoMaker (e.g., Quick Select, Query) are not supported.

**How to Select the Presentation Style and Data Source**

To select a presentation style and data source:

2. On the Object tab, select either **Graph** or **Grid** as your presentation style. These are the only presentation styles supported by WebView.
3. Click **OK**. The Report Generator wizard opens.
4. Select **SQL Select** as your data source. SQL Select is the only data source supported by WebView.
5. Click **Next**. An untitled Report window appears along with the Select Tables dialog box.

**Step 4: Create the SQL Statement**

The fourth step in creating a report template is to create the SQL statement.

**About SQL Statements**

The SQL statement selects the data to be included in the report.

**Note**

This guide assumes that you already have a good knowledge of SQL and the ICM database. ICM tables are described in-depth in the *Cisco ICM Software Database Schema Handbook*. Prior to creating your SQL statement (and, indeed, a new template), it might also be a good idea to examine a similar standard ICM report template.

Creating the SQL statement consists of:

- Selecting the tables and columns to use in the template.
- Optionally, creating computed columns.
- Creating a retrieval argument.
- Constructing a Where clause.
Step 4: Create the SQL Statement

Note

InfoMaker allows you incorporate elements in SQL statements that are not covered in this guide (e.g., Group Bys). For information on these additional elements consult your InfoMaker documentation.

How to Select the Template Database Tables and Columns

To select the database tables and columns to use in your template:

1. In the Select Tables dialog box, select one or more database tables whose data will appear in the template.

Note

For grid templates that will use WebView’s drill-down feature, make sure that your table selection includes the configuration table for the template’s report category. For example, Templates for the Peripheral Services category must include the Service table. Templates for the Skill Group category must include the Skill_Group table. For more information about the types of templates that can use drill-down, see How to Enable a Grid Template for Drill-Down, page 28.

2. Click Open. The tables you selected display in the SQL Select Painter window.
   - The SQL Select Painter consists of two sections: the Table Select window (upper), and the SQL Toolbox window (lower).
   - To select additional tables, right-click in an empty area in the Table Select window and choose Select Tables from the popup menu.
   - To deselect a table, right-click on its title and choose Close from the popup menu.

Cisco ICM Software Custom Screen Builder Guide
3. In each table, select the columns that you want to display in the report. The columns you select display in the left side of the Sort tab in the SQL Toolbox.
   - For drill-down reports, make sure that your selected columns include EnterpriseName from that category’s configuration table.
   - To deselect a column, click its name a second time.

4. Optional: If the report’s presentation type is grid, you can specify the column order and sort order by dragging column names from the left side of the Sort tab to the right.
   - Within the right-side of the Sort tab, you can drag columns up and down to arrange into the position you want them to appear in the report.
   - By default, column values are sorted in ascending order. To sort a column in descending order, clear its Ascending checkbox. In an actual report, records will be sorted initially using the first column’s sort order. For records whose first column value is identical, the next column’s sort order will be used, and so on.
How to Create the Retrieval Argument(s)

About Retrieval Arguments for WebView Reports

When they generate a report, WebView users specify retrieval criteria whose values are passed to the template. To enable your template to use these values, you must define corresponding retrieval arguments in your SQL select statement.

Each WebView template must include a specific set of retrieval arguments:

- All templates must include an argument that retrieves a list of IDs for the report category. For example, call type templates must include an argument that retrieves a list of call type IDs. The data type of the ID argument is always NumberArray.
- Historical templates must also include start date and end date arguments. The data type for both is DateTime.

⚠️ Caution

These are the only arguments supported for WebView reports. Templates that include arguments beyond those described here will fail to retrieve data in WebView.

How to Create the Retrieval Argument(s)

To create the template’s retrieval argument(s):

1. From the InfoMaker Design menu, choose Retrieval Arguments. The Specify Retrieval Arguments dialog box opens.
2. In the Name field, enter a name for the ID argument. The name should not include spaces.
   Example: skill_set_id
3. From the Type drop-down list, select NumberArray.
4. If you are creating a historical report, click Add and create additional arguments for the start and end date, using DateTime as the data type.
5. Click OK. The Specify Retrieval Arguments dialog box closes.

How to Construct the Where Clause

The statement’s Where clause uses the retrieval arguments you created to limit data retrieval to records that match certain criteria. If desired, you can add additional Where criteria that do not use arguments to further narrow the scope of the report.

To specify the Where criteria:

1. In the SQL Toolbox, click the Where tab.
2. In the **Column** drop-down list, select the table column whose data will be matched against your first retrieval argument.

**Note** An ID argument must reference a specific database column based on its report category. Appendix B, “Template Libraries and Report Categories” lists the database columns to use with each report category.

3. In the **Operator** drop-down list, select the operator you want to use.

4. In the **Value** field, right-click and select Argument from the popup menu.

5. A dialog box opens displaying the list of defined arguments. Select the argument appropriate for your column.

6. As necessary, to add additional Where criteria, from the **Logical** drop-down list, select AND.

**Note** Because the DateTime intervals specified in the historical database represent the *beginning* of an interval, Argument end date expressions must use < (not <= ) as the operator.

Example: A historical report might contain these elements:

Column: my_table.entityID
Operator: =
Value: :NumberArray

AND
Column: my_table.my_date
Operator: >=
Value: :start_date

AND
Column: my_table.my_date
Operator: <
Value: :end_date

---

**How to Create a Computed Column**

Optionally, you can create computed columns that reflect calculations based on the values of two more database columns. You can create computed columns in both real-time and historical templates.

**Note** You can also create computed columns later in the template creation process when designing the template’s layout in the Report Painter.
To create a computed column:

1. In the SQL Toolbox, click the **Compute** tab.
2. In the **Computed Columns** field, enter a name for the column followed by an equal (=) sign. The computed column name cannot contain spaces.
3. Right-click to the right of the equal sign and select **Columns** from the popup menu.
4. Select the column you want to use and click **Paste**. The column is entered into the **Computed Columns** field.
5. Enter the symbol for the mathematical operation you want to perform (e.g., +, -, /, *).
6. Right-click again in **Computed Columns** and again select **Columns** from the popup menu.
7. Select a second column to act upon the first and click **Paste**.

---

**Note**  
When your computed column is complete, it is added to the list of template columns on the left-side of the **Sort** tab in the SQL Toolbox.

---

**How to View and Save a Completed SQL Statement**

After completing your template’s SQL statement, you can view the entire statement by clicking the **Syntax** tab in the SQL Toolbox.

An example of a completed SQL statement that includes a computed field (AvgHandleTime) and ID, start date, and end date arguments:

```sql
SELECT Service.EnterpriseName,  
       Service_Half_Hour.DateTime,  
       Service_Half_Hour.CallsOfferedToHalf,  
       Service_Half_Hour.CallsHandledToHalf,  
       Service_Half_Hour.AvgDelayQToHalf,  
       Service_Half_Hour.HandleTimeToHalf,  
       Service_Half_Hour.ServiceLevelToHalf,  
       Service_Half_Hour.CallsAbandQToHalf,  
       AvgHandleTime=Service_Half_Hour.HandleTimeToHalf/Service_Half_Hour.CallsHandledToHalf  
FROM Service, Service_Half_Hour  
WHERE ( Service.SkillTargetID =  
       Service_Half_Hour.SkillTargetID ) and  
       ( ( Service.SkillTargetID = :servicesList )  
       AND  
       ( Service_Half_Hour.DateTime >= :start_date )  
       AND  
       ( )  

```

---

Cisco ICM Software Custom Screen Builder Guide
( Service_Half_Hour.DateTime < :end_date ) )
ORDER BY Service.EnterpriseName ASC,
Service_Half_Hour.DateTime DESC,
Service_Half_Hour.CallsOfferedToHalf ASC

How to Save a SQL Statement

If desired, InfoMaker allows you to save a SQL statement so that it can be retrieved and used in other report templates.
To save a SQL statement:
1. With the statement displayed in the SQL Select Painter, on the InfoMaker toolbar, click Save. A dialog box opens prompting
2. Enter name for the statement.
3. Select the library file in which to save it.
4. Click OK.

Step 5: Design the Template Layout

Once you have completed the SQL Select statement, you are ready to design the template’s layout. Different options are available depending on whether your template’s presentation style is graph or grid.

How to Design the Layout for a Graph Template

To specify the layout for a graph template:
1. After completing the template’s SQL statement, on the InfoMaker toolbar, click Return. The Define Graph Data dialog box opens.
2. From the Category drop-down list, select the template column you want to assign to the Category axis. This represents the column whose values will serve as the grouping criteria for the report.
3. From the Values drop-down list, select the template column that you want to assign to the Values axis. This represents the column whose values will be measured for each category.
4. Optionally, if you want to graph more than one series, select the Series checkbox and specify the column that will provide the series values.
5. Click Next. The Define Graph Style dialog box appears.
6. In the Title field, enter a title for the report. This is the text that will appear at the top of the report when it is viewed online or printed. It also appears alongside the template file name when the template is listed in WebView.
7. In **Graph Type**, select the graph’s graph type (e.g., pie chart, bar chart, etc.).

8. Click **Next**. The attributes of the graph of the graph are displayed.

9. Click **Finish**. The Specify Retrieval Arguments dialog box opens. Enter valid arguments for the template and click OK. The report displays in the Report Painter window.

**Figure 3-4  The Report Painter - Graph**

---

**About Additional Design Options**

Once your template launches in the Report Painter, it is functionally complete and ready to save and use.

The Report Painter gives you additional options for customizing the design of report templates (for example, setting font and print specifications, creating footers, and so on). It also allows you to change the selections you made earlier in the Define Graph Data dialog box. These and other uses of the Report Painter window lie outside the scope of this document. For more information on using the Report Painter, consult your InfoMaker documentation.
How to Design the Layout for a Grid Template

To specify the layout for a grid template:

1. After completing the template’s SQL statement, on the InfoMaker toolbar, click **Return**. The Grid Report Generator dialog box opens.

   **Note**
   If, when you click **Return**, the following message displays: "Data conversion resulted in overflow. Do you want to correct errors?" select **Yes** and then click **Return** again.

2. As desired, specify the template’s background, text, and column colors.

3. Click **Next**. The attributes of the graph of the graph are displayed.

4. Click **Finish**. The Specify Retrieval Arguments dialog box opens. Enter valid arguments for the template and click **OK**. The report displays in the Report Painter window.

*Figure 3-5 The Report Painter - Grid*
How to Create a Report Title

As desired, you can create title text and other header information to display at the top of your report.

To create a report title:
1. In the Design window, click and drag the Header bar down to enlarge the header area.
2. Select the column headers in the header area and move them down, creating an empty area above them. Use CTRL click to select multiple headers
   a. On the InfoMaker toolbar, click Text. A selected Text field appears above the column headers.
3. In the Properties window, modify the column header’s text, border, alignment, and other attributes as desired.

How to Modify Column Header Properties

As desired, you can modify the display attributes (label, font, alignment, etc.) of the column headers that appear in your report.

To modify column header attributes:
1. In the Design window, in the Header Row box, click the column header you want to modify. The header’s attributes display in the Properties Window.
2. In the Properties window, modify the column header’s text, border, alignment, and other attributes as desired.

How to Modify Column Data Properties

As desired, you can modify the display attributes (borders, font, alignment, etc.) of your grid report column data.

To modify column data attributes:
1. In the Design window, in the Detail Row box, click the column you want to modify. To select multiple columns, hold down the Ctrl key as you select them. The column’s attributes display in the Properties Window.
2. In the Properties window, modify the data column’s font, border, alignment, format, and other attributes as desired.

How to Modify the Display Format of Column Data

As desired, you can modify the format in which a column’s data is displayed. For example, you could change the format of a column whose data displays as a decimal so that it displays as a percent.
To change a column’s display format:

1. In the Header row, click the column’s header to select it.
2. From the **Edit** menu, choose **Select > Select Below** to select all rows in the column.
3. From the **Format** menu, select a format for the column (e.g., Percent).

**Note** You can also set the display format for a column by selecting it and then clicking the Format tab in the Properties window.

### How to Adjust Row Height and Column Width

InfoMaker does not automatically size grid cells to display all header and detail text. In most cases, some manual resizing is required.

To adjust the height and width of template rows and columns:

1. To adjust width, in the Design window, click and drag column rules to their desired width.
2. To adjust the height of the header row, in the Design window, click and drag the **Header Bar**.
3. To adjust column width, in the Design window, click and drag the **Detail Bar**.

### How to Add a Data Summary Row

You may want to add a row that will summarize (e.g., give a total or average of) the values in some of the template’s data columns.

To add a data summary row:

1. In the Design window, click and drag the **Summary** bar to create room for a new blank row.
2. In the Header Box, click the header of the first column for which you want to create a summary.
3. From the **Edit** menu, choose **Select > Select Below** to highlight all the cells in the column.
4. From the **Insert** menu, choose **Control >** followed by the desired summary type (i.e., **Average**, **Count**, or **Sum**). A summary field for the column is added to the new row displaying the field’s syntax.
5. Repeat steps 1-4 to add additional summary fields, as desired.

**Note** Some summary fields may require more complex calculations than can be described in this guide. Examples of more complex calculations can be found in some of the ICM WebView standard templates.
6. To add a row label for the summary row:
   a. On the InfoMaker toolbar, click Text.
   b. In the Detail window, click in an open area in the summary row. A selected Text box appears.
   c. On the General tab in the Properties window, navigate to the Text field and enter a label.

How to Enable a Grid Template for Drill-Down

WebView’s drill-down feature allows users to launch a detailed sub-report from within the current report window. The sub-report uses the same retrieval argument values as the report from which it was launched.

Drill-down is supported for grid templates only, and only for templates created for these report categories:
- Enterprise Service
- Enterprise Skill Group
- Peripheral
- Peripheral Service
- Peripheral Skill Group

To enable a valid template for drill-down:
1. In the detail row in the Design window, click the <tablename>.enterprisename column.
2. In the General tab in the Properties window, delete the table name and leading dot from the column name, so that it reads enterprisename.

About Additional Design Options

The Report Painter gives you additional options for customizing the design of report templates (for example, setting font and print specifications, and so on). These and other uses of the Report Painter window lie outside the scope of this document. For more information on using the Report Painter, consult your InfoMaker documentation.

Step 6: Preview the Template

To check layout, you can preview report templates directly from within InfoMaker. Templates can be previewed with or without data, and can be previewed regardless of whether or not they are open at the time.
How to Preview an Open Template

You can preview open templates in the Preview window in the Report Painter. The Preview window is a child window which, by default, is tiled within the Report Painter. For best viewing, it should be maximized.

To maximize the Preview window:
1. In the Report Painter, position your mouse point near the top of the Preview window, until a window bar with a Maximize button appears.
2. Click the Maximize button. The Preview window expands to full-screen mode.
3. Optionally, to retrieve data into the displayed template, from the Rows menu, select Retrieve. If prompted, provide values for required arguments.

How to Preview a Closed Template

At any time, from any place in InfoMaker, you can preview any template in the current library, even if the template is not currently open.

To preview a closed template:
1. From the File menu, select Run/Preview. The Run/Preview dialog box opens, displaying all of the templates in the current library.
   - To preview a template from a different library, close the dialog box and set the current Library as described in “Step 2: Specify the Report Category” above.
2. Select the template you want to preview and click OK. The template displays in preview mode.
3. Optionally, to retrieve data into the displayed template, from the Rows menu, select Retrieve. If prompted, provide values for required arguments.

Step 7: Save the Template

The last step in creating a template is to save it. (Note that you can--and are advised to--save at any point during the process.) When you save a template it saves within the current library file.

To save a report template:
1. With the template displayed in the Report Painter, from the File menu, select Save As. The Save Report dialog box opens.
2. Enter a name for the new template. When naming a template:
   - You cannot use spaces.
Step 7: Save the Template

Because the template name will display in WebView, it’s a good idea to choose an intuitive name that describes some of the template’s basic attributes (e.g., category, content, and presentation type).

Avoid choosing a name that could be overwritten by subsequent installations of ICM which include additional standard templates. A simple workaround to this is to affix the word "custom" to the end of the name; for example: persvc_calls_offered_day_graph_custom.

3. In the Comments field, enter a brief description of the template. This description will display below the template name when it is listed in WebView.

4. Click OK.

Note: Once you save your template, it can be deployed (made visible) in WebView. For instructions on deploying templates, see Chapter 5, “Deploying Custom Templates.” That chapter also describes methods for "hiding" incomplete or untested templates from WebView.
Editing and Deleting Templates

This chapter describes how to edit and delete existing template files. It contains these sections:

- How to Edit a Template
- How to Delete a Template

How to Edit a Template

You can modify any ICM template, including the default templates that ship with ICM. In addition to simple modification of an existing template’s layout or data source, you can use editing to create new templates from existing ones (by saving a modified file under a new name).

To edit a template:

1. Set the template’s library as the current library file:
   a. From the InfoMaker main window, on the toolbar, click **Library**. The Library Painter opens.
   b. Browse to the subdirectory containing the template you want to edit.
   c. Right-click on the subdirectory’s library file (*ppb050.pbl*). From the popup menu, select **Set as Working Library**.

2. Double-click on the library file to display its contents.

3. Double-click the name of the template you want to edit. The template opens in the Report Painter.

   - To modify the template’s data source (SQL select statement), from the **Design** menu in the Report Painter, select **Data Source**. The template opens in the SQL Select Painter. When you are done making modifications in the SQL Select Painter, from the **File** menu, select **Close** to return to the Report Painter.
5. To save your modifications, from the **File** menu, select **Save**, OR, to save the modified file as a new template, from the **File** menu select **Save As**.

**Note**

If the goal of your edits is to modify one of the standard templates that ship with ICM, consider saving the file under a new name. If you save the file to its original name, and subsequently need to reinstall the Admin Workstation, your modifications will be overwritten.

---

**How to Delete a Template**

As necessary, you can delete template files. Once a template is deleted, it is no longer available for use in WebView.

To delete a template:

1. From the InfoMaker main window, on the toolbar, click **Library** to open the Library Painter.
2. Browse to the directory containing the template’s library file.
3. Double-click the library file to display its contents.
4. Right click on the template you want to delete.
5. From the popup menu, select **Delete**.
6. Refresh the report cache to make certain the template’s menu item is removed from WebView (for instructions on refreshing the cache, see “How to Refresh the Reporting Cache” section on page 33).

**Caution**

If WebView users have created and saved reports based on a subsequently deleted template, these reports will continue to exist in WebView and will throw errors when run. Therefore, after deleting a template, be certain to delete any associated reports in WebView.
Deploying Custom Templates

This chapter describes how to open new templates in ICM WebView and how to distribute your custom templates to make them available to other Admin Workstation installations. It contains these sections:

- How to Access New Templates in WebView
- How to Prevent a Template from Displaying in WebView
- How to Distribute Templates to Other Template Libraries

How to Access New Templates in WebView

The custom templates you create in Custom Screen Builder are immediately available to ICM WebView and, following a refresh of the report cache, appear alongside the standard report templates in the WebView interface.

How to Refresh the Reporting Cache

Template file names are stored in a cache on the Admin Workstation server. At startup, WebView reads this cache to determine what templates are available for use. When you create a new template, it may be necessary to refresh the cache before your new template becomes visible in WebView.

There are two ways to refresh the cache:

- The reporting cache refreshes automatically based on a configurable refresh rate. The default refresh rate is 120 minutes. For instructions on configuring the cache refresh rate, see the WebView User Guide.
- You can force a manual refresh of the cache by restarting the Web Server (i.e., IIS) on your Admin Workstation.
How to Start WebView

To start ICM WebView:

1. Open a browser window. In the Address bar, enter a URL comprised of the ICM Admin Workstation server host name and the name of your ICM instance. For example: http://my_aw_server/instance1. The WebView Login page opens.

2. In Login Name, enter the WebView server domain followed by a slash followed by your username. For example: my_webview_domain/my_username.

3. In Password, enter your WebView password.

4. Click Log in. The WebView splash page opens.


How to Open a Template in WebView

To open a template in WebView:

1. From the report menus on the left side of the WebView screen, expand the menu that corresponds to the template’s report type.

2. Select Create a Report.

3. Select the desired template and Click Next.

4. As prompted, select whatever items you want to include in the report. If you are creating a historical report, you will also be prompted to specify a date/time range.

5. Click Finish.

Once you generate a report from a template, you can save it to a report definition file. The custom report templates remain listed in the template launcher until you delete them.

Note For more information on accessing and using WebView, see the WebView Installation Guide and WebView’s online Help.

How to Prevent a Template from Displaying in WebView

In some cases, you may prefer that a template not be available in WebView; if, for example, it is only partially complete or requires a period of internal testing.

There are several strategies you can use to “hide” a template from WebView until such time as you are ready to make it visible.
• WebView only displays templates that contain valid SQL arguments. Therefore, you can hide a template by omitting its arguments until you are ready to use it.

• WebView only displays templates stored in the standard libraries that ship with ICM. Therefore, you can hide a template by creating and storing it in your own library file. Once you are ready to use it, you can move it to one of the standard template libraries.

How to Distribute Templates to Other Template Libraries

To make a custom report template available from a different Admin Workstation, or from a different library on the current Workstation server, you must copy its file and move the copy to the desired target library.

There are two ways to move a copy of a template file to a library:

• Directly using InfoMaker: If you are copying a template to a different library on the current Admin Workstation server, or if you are copying it to a library on a different AW and your Admin Workstation server has a direct network connection to the target AW, you can complete the move within InfoMaker.

• Indirectly using a file transfer: If you are copying a template to a library on a different Admin Workstation server and your Admin Workstation server does not have a direct network connection to the target AW, you must transfer the template’s entire library to the target AW using an available file transfer method (for example, email attachment, FTP, diskette, etc.). You then use InfoMaker to extract a copy of the desired template from the transferred library and place it in the target library.

How to Move Template Files Using InfoMaker

Use this method when copying a template to a different library on the current Admin Workstation server, or when copying it to a library on a different AW if you have a direct network connection to the target AW.

To move a template file using InfoMaker:

1. Start Cisco Custom Screen Builder.
2. On the InfoMaker toolbar, click Library.
3. Browse to the Library containing the template you want to copy. Expand the Library to display its templates.
4. Right-click on the desired template and select Copy from the popup menu. The Select Library dialog box opens.
5. Browse to the target template library.
6. Click Open. If that library already contains an identically named template, InfoMaker will prompt you for confirmation before it overwrites the file.
How to Move Template File Using a File Transfer

Use this method when copying a template to a library on a different Admin Workstation server to which you do not have a direct network connection.

To move as template file using a file transfer method:

1. Transfer a copy of the template’s library (.pbl) file to the target Admin Workstation server using any standard file transfer method (e.g., as an email attachment, via FTP, Telnet, diskette, etc.).

2. On the target AW, when the library file is received:
   a. Start Custom Screen Builder.
   c. Browse to the location of the transferred file and add it to your Library list.
   d. Click OK.
   e. On the InfoMaker toolbar, click Sel Lib:
   f. Browse to the location of the transferred library file.
   g. Expand the Library to display its templates.
   h. Right-click on the desired template and select Copy from the popup menu. The Select Library dialog box opens.
   i. Browse to the target template library.
   j. Click Open. If that library already contains an identically named template, InfoMaker will prompt you for confirmation before it overwrites the file. Right-click and choose Copy. The Select Library dialog box appears.

**Note**
Similarly, you could use this method to overwrite an entire template library file with one from a different AW. Note however that this will not cause the loss of customized templates currently stored in the overwritten library.
Creating Sample Report Templates

As practice, you may want to try creating several sample templates before undertaking your first actual WebView template. This appendix provides specifications you can use to create several sample templates. It contains these sections:

- How to Create a Sample Real-Time Template
- How to Create a Sample Historical Template

The instructions provided in this appendix assume that you are familiar with the basics of Custom Screen Builder described in previous chapters.

How to Create a Sample Real-Time Template

This section provides instructions for creating a sample real-time report template for use with peripheral services.

About the Sample Real-Time Template

You will be creating a graph template that displays data for several selected peripheral services. This template will use real-time data from the Admin Workstation local database. The template’s SQL statement will use a single retrieval argument. The completed template will produce a report that looks similar to the following example.
For each service, this template shows two pieces of information from the tables in the Admin Workstation local database:

- Enterprise Name (from the Service table) is the category, or subject of the report template. The category identifies the entities for which the template will retrieve data.
- Calls Offered Half (from the Service_Real_Time table) is the value displayed for each entity.

**How to Create the Sample Real-Time Template**

Create the sample real-time template using the specifications described in the table below, and following the instructions for creating a new template described in Chapter 3, “Creating a New Report Template.”

**Table A-1 Sample Real-time Template Specifications**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Create a real-time template using the ICM real-time db: RealTimeDB</td>
</tr>
<tr>
<td>Reporting Element / Template Library</td>
<td>Specify Peripheral Services as the template’s reporting element by selecting this library in which to create the template: icm&lt;icm_instance_name&gt;\aw\custom\persvc\ppb050.pbl</td>
</tr>
<tr>
<td>Presentation Style</td>
<td>Select the following as the presentation style: Graph: 3D Pie chart</td>
</tr>
</tbody>
</table>
About the Sample Historical Template

You will be creating a grid template that displays data for selected peripheral services. This template will use historical data from the ICM central database. The template’s SQL statement will use three retrieval arguments including (because it is a historical template) a start and end date. It will also include one computed field.

The completed template will produce a report that looks similar to the following example.

**Table A-1 Sample Real-time Template Specifications (continued)**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tables</td>
<td>Select these tables for use in the template:</td>
</tr>
<tr>
<td></td>
<td>- Service</td>
</tr>
<tr>
<td></td>
<td>- Service_Real_Time</td>
</tr>
<tr>
<td>Table Columns</td>
<td>Select these table columns for use in the template:</td>
</tr>
<tr>
<td></td>
<td>- Service.EnterpriseName</td>
</tr>
<tr>
<td></td>
<td>- Service_Real_Time.CallsOfferedHalf</td>
</tr>
<tr>
<td>Retrieval Argument</td>
<td>Create a retrieval argument with these attributes:</td>
</tr>
<tr>
<td></td>
<td>Name: list_of_persvc</td>
</tr>
<tr>
<td></td>
<td>Type: Number array</td>
</tr>
<tr>
<td>Where Clause</td>
<td>Create a Where clause with these attributes:</td>
</tr>
<tr>
<td></td>
<td>Column: Service.SkillTargetID</td>
</tr>
<tr>
<td></td>
<td>Operator: IN</td>
</tr>
<tr>
<td></td>
<td>Value: (argument):list_of_persvc</td>
</tr>
<tr>
<td>Layout:</td>
<td>In the Define Graph Data dialog box, set these attributes for the template:</td>
</tr>
<tr>
<td></td>
<td>Category Axis: Service_EnterpriseName</td>
</tr>
<tr>
<td></td>
<td>Values Axis: Service_Real_Time_CallsOfferedHalf</td>
</tr>
<tr>
<td></td>
<td>Title: Tasks Offered</td>
</tr>
<tr>
<td></td>
<td>Graph Type: 3D Pie Chart</td>
</tr>
<tr>
<td>Template File Name</td>
<td>Save the template as:</td>
</tr>
<tr>
<td></td>
<td>custom_realtime_tasks_offered</td>
</tr>
</tbody>
</table>

How to Create a Sample Historical Template

This section provides instructions for creating a sample historical report template for use with peripheral services.
For each service, this template shows the following pieces of information from the tables in the ICM central database:

- Enterprise Name (from the Service table) is the category, or subject of the report template. The category identifies the entities for which the template will retrieve data.

- From the Service_Half_Hour table, the following values are displayed for each entity in the report template:
  - DateTime
  - CallsOfferedToHalf
  - CallsAbandQToHalf
  - ServiceLevelToHalf
  - AvgDelayQToHalf
  - CallsHandledToHalf
  - HandleTimeToHalf

This historical template also presents an additional value, AvgHandleTime. This value is computed from two field values in the SQL syntax.

**How to Create the Sample Historical Template**

Create the sample historical template using the specifications described in the table below, and following the instructions for creating a new template described in Chapter 3, “Creating a New Report Template.”
How to Create a Sample Historical Template

Table A-2  Sample Historical Template Specifications

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Create a historical template using the ICM historical db: HistoricalDB</td>
</tr>
<tr>
<td>Reporting Element / Template Library</td>
<td>Specify Peripheral Services as the template’s reporting element by selecting this library in which to create the template: icm&lt;icm_instance_name&gt;\aw\custom\persvc\ppb050.pbl</td>
</tr>
<tr>
<td>Presentation Style</td>
<td>Select the following as the presentation style: Grid</td>
</tr>
<tr>
<td>Tables</td>
<td>Select these tables for use in the template:</td>
</tr>
<tr>
<td></td>
<td>- Service</td>
</tr>
<tr>
<td></td>
<td>- Service_Real_Time</td>
</tr>
<tr>
<td>Table Columns</td>
<td>Select these table columns for use in the template:</td>
</tr>
<tr>
<td></td>
<td>- Service.EnterpriseName</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.DateTime</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.CallsOfferedToHalf</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.CallsAbandQToHalf</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.ServiceLevelToHalf</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.AvgDelayQToHalf</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.CallsHandledToHalf</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.HandleTimeToHalf</td>
</tr>
<tr>
<td>Computed Field</td>
<td>Create a computed field with these attributes:</td>
</tr>
<tr>
<td></td>
<td>Name: AvgHandleTime</td>
</tr>
<tr>
<td></td>
<td><strong>Computation:</strong> Service_Half_Hour.HandleTimeToHalf divided by (/) Service_Half_Hour.CallsHandledToHalf.</td>
</tr>
<tr>
<td>Retrieval Argument</td>
<td>Create three retrieval arguments with these attributes:</td>
</tr>
<tr>
<td></td>
<td>Name: services_list</td>
</tr>
<tr>
<td></td>
<td><strong>Type:</strong> Number array</td>
</tr>
<tr>
<td></td>
<td>Name: start_date</td>
</tr>
<tr>
<td></td>
<td><strong>Type:</strong> DateTime</td>
</tr>
<tr>
<td></td>
<td>Name: end_date</td>
</tr>
<tr>
<td></td>
<td><strong>Type:</strong> DateTime</td>
</tr>
</tbody>
</table>
### Table A-2  Sample Historical Template Specifications (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Where Clause</td>
<td>Create a three part Where clause with these attributes:</td>
</tr>
<tr>
<td></td>
<td><strong>Column</strong>: Service.SkillTargetID</td>
</tr>
<tr>
<td></td>
<td><strong>Operator</strong>: IN</td>
</tr>
<tr>
<td></td>
<td><strong>Value</strong>: (argument) :services list</td>
</tr>
<tr>
<td></td>
<td><strong>AND</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Column</strong>: Service_Half_Hour.DateTime</td>
</tr>
<tr>
<td></td>
<td><strong>Operator</strong>: &gt;=</td>
</tr>
<tr>
<td></td>
<td><strong>Value</strong>: (argument) :start_date</td>
</tr>
<tr>
<td></td>
<td><strong>AND</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Column</strong>: Service_Half_Hour.DateTime</td>
</tr>
<tr>
<td></td>
<td><strong>Operator</strong>: &lt;</td>
</tr>
<tr>
<td></td>
<td><strong>Value</strong>: (argument) :end_date</td>
</tr>
<tr>
<td>Sort Order</td>
<td>Set the sort order so that records display first byService.EnterpriseName in ascending order, and then by Service_Half_Hour.DateTime in descending order.</td>
</tr>
<tr>
<td>Layout:</td>
<td>In the Report Painter, set these attributes for the template:</td>
</tr>
<tr>
<td>Title:</td>
<td><strong>Tasks Offered</strong></td>
</tr>
<tr>
<td>Column Names:</td>
<td>Modify the default Column Header names to the following:</td>
</tr>
<tr>
<td></td>
<td>- Service.EnterpriseName to Peripheral Service Name</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.DateTime to Date and Tim</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.CallsOfferedToHalf to Calls Offered</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.CallsAbandQToHalf to Calls Aband. in Queue</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.ServiceLevelToHalf to Service Level%</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.AvgDelayQToHalf to Avg. Delay in Queue</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.CallsHandledToHalf to Calls Handled</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.HandleTimeToHalf to Handle Time</td>
</tr>
<tr>
<td></td>
<td>- AvgHandleTime to Avg. Handle Time</td>
</tr>
</tbody>
</table>
### Table A-2  **Sample Historical Template Specifications (continued)**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout (cont’d):</td>
<td>Row and Column Formatting:</td>
</tr>
<tr>
<td></td>
<td>- Adjust row heights and column widths to appropriate viewing sizes.</td>
</tr>
<tr>
<td></td>
<td>- Center all Column header labels. Set all numeric column data to align right.</td>
</tr>
<tr>
<td></td>
<td>- Set the display format of data in the Service_Half_Hour.ServiceLevelToHalf column to percent (%).</td>
</tr>
<tr>
<td></td>
<td>- Summary row: Create a summary row that includes data totals for the following:</td>
</tr>
<tr>
<td></td>
<td>Average of Service_Half_Hour.ServiceLevelToHalf</td>
</tr>
<tr>
<td></td>
<td>Sum of Service_Half_Hour.CallsOfferedToHalf</td>
</tr>
<tr>
<td></td>
<td><strong>Sum of</strong> Service_Half_Hour.CallsAbandQToHalf</td>
</tr>
<tr>
<td></td>
<td><strong>Sum of</strong> Service_Half_Hour.CallsHandledToHalf</td>
</tr>
<tr>
<td></td>
<td><strong>Sum of</strong> Service_Half_Hour.HandleTimeToHalf</td>
</tr>
<tr>
<td>Drill-down Capability</td>
<td>If you want to enable this report to use WebView’s drill-down feature, in the Report Painter,</td>
</tr>
<tr>
<td></td>
<td>modify the name of the Service.EnterpriseName column to enterprisename.</td>
</tr>
<tr>
<td>Template File Name</td>
<td>Save the template as:</td>
</tr>
<tr>
<td></td>
<td>custom_task_analysis_half_hour</td>
</tr>
</tbody>
</table>

---
Template Libraries and Report Categories

This appendix describes how ICM stores report templates and provides a listing of WebView report categories. It contains these sections:

- About Template Libraries
- About WebView Report Categories

**About Template Libraries**

ICM report templates are stored in and accessed from PowerBuilder library files (PBLs) on your ICM Workstation server. A separate library file exists for each WebView report category (e.g., call type, routing client), and each library file is stored in its own subdirectory within the `icm\<icm_instance_name>\aw\custom` directory.

It's important that you select the appropriate library when creating a new template: this is what associates the template with a specific WebView report category, ensuring that it displays under the correct menu in WebView and has access to the correct retrieval values.

Both real-time and historical templates are stored in the same library file for a specific report category. So, for example, the templates for *call type* real-time and historical reports are all stored in the library file located in the `caltyp` subdirectory.

WebView will only recognize and display templates from the standard libraries that ship with ICM. In other words, you cannot create your own library files and display their templates in WebView. However, you *can* create your own libraries to store templates under development, or templates that you want to remove from WebView but retain for possible future use. See the InfoMaker documentation for instructions on creating new libraries.

**About WebView Report Categories**

The following table lists all WebView report categories, and their associations:
- Column 1, *WebView Report Category*, lists the name of the report category.
- Column 2, *Library Subdirectory*, lists the subdirectory on the Admin Workstation server where the report category’s library file is stored.
- Column 1, *ID Argument*, lists the ICM database column that should be used with the ID argument (in a template’s SQL statement) for templates of this report category.
- Column 4, *WebView Menu*, lists the menu from which templates that use this report category are available in Webview.

**Table B-1 WebView Report Categories**

<table>
<thead>
<tr>
<th>WebView Report Category</th>
<th>Library Subdirectory:</th>
<th>ID Argument</th>
<th>WebView Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent by Agent</td>
<td>peragt</td>
<td>SkillTargetID</td>
<td>Agent &gt; By Agent</td>
</tr>
<tr>
<td>Agent by Team</td>
<td>agteam</td>
<td>AgentTeamID</td>
<td>Agent &gt; By Team</td>
</tr>
<tr>
<td>Agent by Peripheral</td>
<td>agtper</td>
<td>PeripheralID</td>
<td>Agent &gt; By Peripheral</td>
</tr>
<tr>
<td>Agent by Skill Group</td>
<td>agtskg</td>
<td>SkillGroupSkillTargetID</td>
<td>Agent &gt; By Skill Group</td>
</tr>
<tr>
<td>Application Gateway</td>
<td>apgate</td>
<td>ApplicationGatewayID</td>
<td>Application Gateway</td>
</tr>
<tr>
<td>Application Path</td>
<td>appath</td>
<td>ApplicationPathID</td>
<td>Application Path</td>
</tr>
<tr>
<td>Blended Agent Campaign</td>
<td>bacamp</td>
<td>CampaignID</td>
<td>Blended Agent &gt; Campaign</td>
</tr>
<tr>
<td>Blended Agent Dialer Port</td>
<td>badial</td>
<td>DialerID</td>
<td>Blended Agent &gt; Dialer</td>
</tr>
<tr>
<td>Blended Agent Dialer Port</td>
<td>badprt</td>
<td>DialerID</td>
<td>Blended Agent &gt; Dialer Port</td>
</tr>
<tr>
<td>Blended Agent Import Rule</td>
<td>baimp</td>
<td>ImportRuleID</td>
<td>Blended Agent &gt; Import Rule</td>
</tr>
<tr>
<td>Call Type</td>
<td>caltyp</td>
<td>CallTypeID</td>
<td>Call Type</td>
</tr>
<tr>
<td>Enterprise Skill Group</td>
<td>entskg</td>
<td>EnterpriseSkillGroupID</td>
<td>Skill Group &gt; Enterprise</td>
</tr>
<tr>
<td>Enterprise Service</td>
<td>entsvc</td>
<td>EnterpriseServiceID</td>
<td>Enterprise &gt; Service AND</td>
</tr>
<tr>
<td>Network Trunk Group</td>
<td>nettrk</td>
<td>NetworkTrunkGroupID</td>
<td>Trunk Group &gt; Network</td>
</tr>
<tr>
<td>Peripheral</td>
<td>periph</td>
<td>PeripheralID</td>
<td>Peripheral</td>
</tr>
</tbody>
</table>
### Table B-1 WebView Report Categories (continued)

<table>
<thead>
<tr>
<th>WebView Report Category</th>
<th>Library Subdirectory:</th>
<th>ID Argument</th>
<th>WebView Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peripheral Skill Group</td>
<td>perskg</td>
<td>SkillTargetID</td>
<td>Skill Group &gt; Base Only AND Skill Group &gt; Peripheral</td>
</tr>
<tr>
<td>Peripheral Service</td>
<td>persvc</td>
<td>SkillTargetID</td>
<td>Service &gt; Peripheral</td>
</tr>
<tr>
<td>Route</td>
<td>routes</td>
<td>RouteID</td>
<td>Route</td>
</tr>
<tr>
<td>Routing Client</td>
<td>rtecli</td>
<td>RoutingClientID</td>
<td>Routing Client</td>
</tr>
<tr>
<td>Schedule Import</td>
<td>schimp</td>
<td>ScheduleID</td>
<td>Schedule</td>
</tr>
<tr>
<td>Script Queue</td>
<td>scriptq</td>
<td>ScriptID</td>
<td>Script Queue</td>
</tr>
<tr>
<td>Trunk Group</td>
<td>trkgrp</td>
<td>TrunkGroupID</td>
<td>Trunk Group &gt; Peripheral</td>
</tr>
</tbody>
</table>
Appendix B  Template Libraries and Report Categories

About WebView Report Categories
Index

A
accessing
  Custom Screen Builder 2
templates in WebView 33
WebView 34
Admin Workstation
databases 8, 13
installing Custom Screen Builder on 2
reporting cache on 33
template libraries on 45
arguments
database columns for 9, 20, 45
in Where clause 20
required 9, 20, 34, 45

B
bold font in Cisco documentation ii

cache 33
categories for ICM reports 8, 15, 45
CEM WebView 1
central database 8, 13
chart templates 10, 16, 23, 37
Cisco
documentation iii
technical product assistance iv
Web site iii, iv
columns in SQL statements 18
commands 3
computed columns 21
conventions in Cisco documentation ii
copying
  libraries 36
templates 35, 36
courier font in Cisco documentation ii
creating
  a database profile 15
  computed columns 21
  new templates 10, 13
  new templates from existing 31
  retrieval arguments 20
  sample templates 37
  SQL statements 17
Custom Screen Builder
  accessing 2
  commands and windows 3
  defined 1
  installing 2
  prerequisite software 2
  support for Webview 1

D
databases
  creating profile for 15
  for ICM described 8, 13
  selecting tables in SQL 18
  specifying for template 14
# Index

<table>
<thead>
<tr>
<th>Data Source for Templates</th>
<th>16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Summary Fields</td>
<td>27</td>
</tr>
<tr>
<td>Deleting Templates</td>
<td>32</td>
</tr>
<tr>
<td>Directories for Library Files</td>
<td>45</td>
</tr>
<tr>
<td>Distributor Database</td>
<td>8, 13</td>
</tr>
<tr>
<td>Documentation for Cisco Products</td>
<td>iii</td>
</tr>
<tr>
<td>Document Conventions</td>
<td>ii</td>
</tr>
<tr>
<td>Drill-Down Reports</td>
<td>18, 28</td>
</tr>
<tr>
<td>Editing</td>
<td></td>
</tr>
<tr>
<td>SQL</td>
<td>31</td>
</tr>
<tr>
<td>Template Layout</td>
<td>23</td>
</tr>
<tr>
<td>Templates</td>
<td>31</td>
</tr>
<tr>
<td>E-Mail Manager</td>
<td>1</td>
</tr>
<tr>
<td>Formats for Templates</td>
<td>10, 16</td>
</tr>
<tr>
<td>Graph Templates</td>
<td>10, 16, 23, 37</td>
</tr>
<tr>
<td>Grid Templates</td>
<td>10, 16, 23, 39</td>
</tr>
<tr>
<td>HDS</td>
<td>8, 13</td>
</tr>
<tr>
<td>Historical Database</td>
<td>8, 13</td>
</tr>
<tr>
<td>Historical Reports</td>
<td></td>
</tr>
<tr>
<td>Creating Sample</td>
<td>39</td>
</tr>
<tr>
<td>Defined</td>
<td>7</td>
</tr>
<tr>
<td>Selecting Database for</td>
<td>13</td>
</tr>
<tr>
<td>ICM</td>
<td></td>
</tr>
<tr>
<td>ICM Databases</td>
<td>8, 13</td>
</tr>
<tr>
<td>Report Categories</td>
<td>8, 45</td>
</tr>
<tr>
<td>WebView</td>
<td>1</td>
</tr>
<tr>
<td>ID Arguments</td>
<td>9, 20, 45</td>
</tr>
<tr>
<td>InfoMaker</td>
<td></td>
</tr>
<tr>
<td>Commands and Windows</td>
<td>3</td>
</tr>
<tr>
<td>Installing</td>
<td>2</td>
</tr>
<tr>
<td>Versions</td>
<td>2</td>
</tr>
<tr>
<td>Installing Custom Screen Builder</td>
<td>2</td>
</tr>
<tr>
<td>Italic Font in Cisco Documentation</td>
<td>ii</td>
</tr>
<tr>
<td>Layout, Designing for Template</td>
<td>23</td>
</tr>
<tr>
<td>Libraries</td>
<td></td>
</tr>
<tr>
<td>Copying</td>
<td>36</td>
</tr>
<tr>
<td>Creating</td>
<td>45</td>
</tr>
<tr>
<td>For Use with Report Categories</td>
<td>15, 45</td>
</tr>
<tr>
<td>Location of</td>
<td>45</td>
</tr>
<tr>
<td>Moving</td>
<td>36</td>
</tr>
<tr>
<td>Moving Templates Between</td>
<td>35, 36</td>
</tr>
<tr>
<td>Setting Current</td>
<td>15</td>
</tr>
<tr>
<td>Library Painter</td>
<td>3, 16</td>
</tr>
<tr>
<td>Logging in to WebView</td>
<td>34</td>
</tr>
<tr>
<td>Menus in WebView</td>
<td>45</td>
</tr>
<tr>
<td>Moving Templates</td>
<td>35, 36</td>
</tr>
<tr>
<td>Naming Template Files</td>
<td>29</td>
</tr>
<tr>
<td>Painter Windows</td>
<td>3, 16, 19, 24, 25</td>
</tr>
<tr>
<td>PBLs</td>
<td>45</td>
</tr>
</tbody>
</table>
Index

planning new templates 10
Powerbuilder libraries 45
presentation format 10, 16
previewing templates 28

R
real-time database 8, 13
real-time reports
creating sample 37
defined 7
selecting the database for 13
refreshing the reporting cache 33
report categories
defined 8
for use with drill down 28
libraries and ID arguments for 45
specifying 15
reporting cache 33
Report Painter 3, 24, 25
reports
categories 8, 45
drill-down 18, 28
on WebView menus 45
Webview categories 45
retrieval arguments 9, 20, 45

S
saving
SQL statements 23
templates 29, 31, 45
SQL
creating a Where clause 20
creating computed columns 21
creating statements 17
database tables in 18
ID arguments for report categories 45
in report templates 9, 20
required arguments 34
saving 23
SQL Select Painter 3, 19
starting
Custom Screen Builder 2
WebView 34
summary fields 27
support
for Cisco products iv
for ICM and CEM WebView 1

tables in SQL statement 18
templates
accessing in WebView 33
attributes 7
categories 8, 15, 45
creating 10, 13
creating new from existing 31
creating sample 37
creating SQL statements for 17
deleting 32
designing layout for 23
editing 31
hiding from WebView 34
libraries 15, 45
moving 35, 36
naming 29
planning 10
presentation formats for 10, 16
previewing 28
saving 29, 31, 45
specifying database for 14
specifying data source 16
troubleshooting iv
U

username for WebView  34

V

variables in Cisco documentation  ii

W

Web site for Cisco  iii, iv

WebView
  accessing  34
  accessing templates in  33
  defined  1
  drill down reports  18, 28
  for CEM  1
  for ICM  1
  hiding templates from  34
  menus  45
  report categories  8, 45
  template attributes  7

Webview
  report categories  15

Where clause  9, 20

windows  3, 16, 19, 24, 25